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ControlLogix 5570 Redundancy Update and Module Replacement Guidelines Reference Manual

Important User Information
Read this document and the documents listed in the additional resources section about installation, configuration, and 
operation of this equipment before you install, configure, operate, or maintain this product. Users are required to familiarize 
themselves with installation and wiring instructions in addition to requirements of all applicable codes, laws, and standards.

Activities including installation, adjustments, putting into service, use, assembly, disassembly, and maintenance are required to 
be carried out by suitably trained personnel in accordance with applicable code of practice.

If this equipment is used in a manner not specified by the manufacturer, the protection provided by the equipment may be 
impaired.

In no event will Rockwell Automation, Inc. be responsible or liable for indirect or consequential damages resulting from the use 
or application of this equipment.

The examples and diagrams in this manual are included solely for illustrative purposes. Because of the many variables and 
requirements associated with any particular installation, Rockwell Automation, Inc. cannot assume responsibility or liability for 
actual use based on the examples and diagrams.

No patent liability is assumed by Rockwell Automation, Inc. with respect to use of information, circuits, equipment, or software 
described in this manual.

Reproduction of the contents of this manual, in whole or in part, without written permission of Rockwell Automation, Inc., is 
prohibited.

Throughout this manual, when necessary, we use notes to make you aware of safety considerations.

Labels may also be on or inside the equipment to provide specific precautions.

WARNING: Identifies information about practices or circumstances that can cause an explosion in a hazardous environment, which may 
lead to personal injury or death, property damage, or economic loss.

ATTENTION: Identifies information about practices or circumstances that can lead to personal injury or death, property damage, or 
economic loss. Attentions help you identify a hazard, avoid a hazard, and recognize the consequence.

IMPORTANT Identifies information that is critical for successful application and understanding of the product.

SHOCK HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that dangerous voltage may 
be present.

BURN HAZARD: Labels may be on or inside the equipment, for example, a drive or motor, to alert people that surfaces may reach 
dangerous temperatures.

ARC FLASH HAZARD:  Labels may be on or inside the equipment, for example, a motor control center, to alert people to potential Arc 
Flash. Arc Flash will cause severe injury or death. Wear proper Personal Protective Equipment (PPE). Follow ALL Regulatory requirements 
for safe work practices and for Personal Protective Equipment (PPE).
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Preface

Summary of Changes This table contains the changes that were made to this revision.

Overview This publication provides instructions for replacing modules or updating 
firmware in a powered-up and running enhanced redundancy system.

The following requirements must be met to use this publication:

• Online updates are only permitted for updates from revision 20.054 or 
later.

• The redundancy system is being updated to redundancy revision 
24.052_kit1 or later.

• If doing online updates of a running system, you must go in the 
following revision order: V20.05x > V24.053_kit1 > V30.051_kit1 > 
V31.052_kit1 > V32.051_kit1 > V33.051_kit1

• Online updates are only permitted with a ControlLogix® 5570 controller 
(in both the previous release and the new release, in both the primary 
and secondary chassis).

• A replacement ControlLogix 5570 controller must have memory equal 
to or greater than the memory in the original ControlLogix 5570 
controller.

You can access release notes for each redundancy firmware revision from the 
Rockwell Automation Product Compatibility and Download Center (PCDC).

In a redundant system, modules can be replaced, and firmware can be updated 
using either of the following methods:

• Method 1: Modules are replaced and firmware is updated while the 
redundancy system is powered up and the controllers are left in RUN 
mode. In this case, this publication applies. 

• Method 2: If you power down the redundancy system or take 
controllers out of RUN mode to replace modules, then this method is 
similar to a new installation and this publication does not apply. 
Instead, see the ControlLogix 5570/5560 Redundancy User Manual, 
publication 1756-UM535, and install the modules, firmware, and 
application software versions for the appropriate revision for your 
installation. Compatible module firmware revisions and software 
versions are listed in the Release Notes for the appropriate redundancy 
firmware revision.

For instructions on how to update to revisions previous to 24.052_kit1, see the 
appropriate release notes on the Product Compatibility and Download Center.

Topic Page
Added information for redundancy firmware revision 33.051_kit2. Throughout

IMPORTANT Restrictions with Online Updates:
• If a system is at 20.058_kit1 or 20.058_kit2, it is not possible to update to 

24.052_kit1. You can update to 24.053_kit1.
• If a system is at 30.051_kit2, and uses Ethernet modules with firmware 

revision 11.003 or ControlNet® modules with firmware revision 25.006, it is 
not possible to update to 31.052_kit1 or 31.052_kit2.

• If a system is at 31.052_kit2, and uses Ethernet modules with firmware 
revision 11.002, it is not possible to update to 32.051_kit1.
Rockwell Automation Publication 1756-RM010H-EN-P - January 2021 5
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Preface          
Modernization Services and 
Tools

Throughout the product lifecycle, as products mature, Rockwell Automation is 
there as your partner to help you get the most out of your current equipment. 
Rockwell Automation also helps you determine your next steps and lay out a 
plan for the transition to newer technology.

Rockwell Automation has the tools and the experience to guide you through 
the transition, whether you choose to modernize all at once or use our unique, 
phased approach.

For more information, see the modernization Solutions Brochure, 
publication MIGRAT-BR002.

For tools that assist with planning and configuring an Integrated 
Architecture® system, see the Rockwell Automation Product Selection and 
Configuration website.

Additional Resources These documents contain additional information concerning related products 
from Rockwell Automation.

You can view or download publications at rok.auto/literature.

Resource Description

1756 ControlLogix Controllers Specifications Technical Data, publication 1756-TD001 Technical specifications for ControlLogix® controllers and accessories, including 
redundancy modules.

ControlLogix 5570/5560 Redundancy User Manual, publication 1756-UM535 Provides information to install, configure, and use redundancy systems.
ControlFLASH Firmware Upgrade Kit User Manual, publication 1756-UM105 Provides information on ControlFLASH™ software.
ControlFLASH Plus Quick Start Guide, publication CFP-QS001 Provides information on ControlFLASH Plus™ software.
Modernization Solutions Brochure, publication MIGRAT-BR002 Provides information about modernization.
Integrated Architecture Tools and Resources website, 
Product Selection and Configuration Provides Integrated Architecture® tools and information.

Industrial Automation Wiring and Grounding Guidelines, publication 1770-4.1 General guidelines for installing a Rockwell Automation industrial system.
Product Certifications website, rok.auto/certifications. Provides declarations of conformity, certificates, and other certification details.
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Chapter 1

Update Considerations

Before You Begin When updating products in a ControlLogix® redundancy system, you must:
• Download and install the appropriate redundancy firmware bundle, 

and the compatible versions of the Studio 5000 Logix Designer® 
application, RSLinx® Classic, ControlFLASH™ or ControlFLASH Plus™ 
software, and the Redundancy Module Configuration Tool (RMCT).

• Update the firmware on the redundancy modules, controllers, and 
communication modules in the redundancy chassis pair.

• Update the revision of controller and communication module firmware 
in the redundancy application project.

Topic Page

Before You Begin 7

Download and Install ControlFLASH Software 10

Download the Redundancy Firmware Bundle and RMCT 11

Install the Redundancy Firmware Bundle 14

Install the Redundancy Module Configuration Tool 24

Install the Logix Designer Application 25

Prepare the Controller Project for the Update 25

Update the Redundancy System Firmware 27

IMPORTANT • For redundancy bundles that use firmware revision 20.009 or later for 
1756-RM2 modules, the RMCT is included in the redundancy bundle and is 
not available as an individual download.

• For redundancy bundles that use firmware revision earlier than 20.009, 
you download the RMCT separately as a product add-on.

• In either case above, a separate install is required.

IMPORTANT If you are migrating from an existing revision 30.051 redundancy 
application, use Studio 5000 Logix Designer application version 30.01.00 
or newer. Version 30.00.00 has a known anomaly that sometimes 
prevents you from uploading redundancy projects to a new file, which 
can interfere with the update process. For more information see 
Knowledgebase Article Studio 5000: Anomalies Corrected in Version 30.01.
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Chapter 1          Update Considerations
LINT Members Must Align on 8-byte Boundaries

Beginning with version 27 of the Studio 5000 Logix Designer application, LINT 
members must be aligned on 8-byte boundaries, and User-defined Data Types 
(UDT) that contain LINT members must be sized as a multiple of 8 bytes. 

This change impacts your Logix Designer application project if any of the 
following situations are true:

• You migrate a standard project, version 26 or earlier, to a redundancy 
project that is version 30.051 or later, and you have LINT tags inside a 
UDT.

• You migrate a redundancy project, version 24.053 or earlier, to a project 
that is version 30.051 or later, and you have LINT tags inside a UDT.

• You use a tag with LINT members as a producer, and at least one 
consumer (controller) has firmware earlier than version 27.

• You use a tag with LINT members as a consumer, and the producer 
(controller) has firmware earlier than version 27.

For more information, see these resources: 
• Align LINT Members on 8-byte Boundaries on page 51
• Logix Designer application online help topic: ‘LINT data types within 

this tag now align on 8-byte boundaries. Check produce/consume 
connection’.

IMPORTANT If you have User-defined Data Types (UDT) that contain LINT members, 
you may not be able perform the online Redundancy System Update. See 
the ControlLogix 5570/5560 Redundancy User Manual, publication
1756-UM535, on how to install and update the modules, firmware, and 
application software versions while offline. 

IMPORTANT If you attempt to perform a Redundancy System Update from version 
24.05x to version 30.051 or later, and you have LINT tags inside a UDT, 
the Lock for Update attempt can fail.
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Chapter 1          Update Considerations
Verify Your RMCT Version

Complete these steps to check or verify the version of the RMCT you have 
installed.

1. Launch RSLinx Classic software.
2. Click the RSWho icon.

3. Right-click your redundancy module and choose Module 
Configuration.

The Module Configuration dialog box opens.
4. Right-click the title bar and choose About.

IMPORTANT If you have RMCT version 7 or earlier, it does not support the 1756-RM2 
modules. For more information on the RMCT, see Knowledgebase Article 
Redundancy Module Configuration Tool (RMCT).

IMPORTANT You must uninstall any existing version of the Redundancy Module 
Configuration Tool (RMCT) before you install the RMCT, version 8.4.1.0 or 
later. If you do not uninstall the previous version, you can have difficulty 
if you try to uninstall version 8.4.1.0 or later at another time.

If Module Configuration is not available in the list of options, RMCT 
version 8.4.1.0 has not been installed. 
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Chapter 1          Update Considerations
The About dialog box opens and indicates the RMCT version.

Download and Install 
ControlFLASH Software

If you upgrade to redundancy firmware revision 30.051, 31.052, 32.051, or 
33.051, ControlFLASH and ControlFLASH Plus software is not included in the 
redundancy firmware revision kits. 

To find the compatible version of ControlFLASH and ControlFLASH Plus 
software to download, go to the Product Compatibility and Download Center 
and view the release notes for your redundancy firmware revision kit.

For information on how to download and install ControlFLASH or 
ControlFLASH Plus software, see:

• ControlFLASH Firmware Upgrade Kit User Manual, publication
1756-UM105

• ControlFLASH Plus Quick Start Guide, publication CFP-QS001

The RMCT launches at the version that is compatible with the 
1756-RM2 or 1756-RM2XT redundancy module firmware that is 
installed.
You must update your RMCT version and the redundancy module 
firmware revision so it is compatible with the new RMCT version. If 
you do not perform this update, the About dialog box cannot reflect 
the new RMCT version.

IMPORTANT If you are only upgrading to redundancy firmware revision 24.052, the 
compatible version of ControlFLASH software is included in redundancy 
firmware revision 24.052_kit1. However, ControlFLASH 14.01.00 is 
compatible with redundancy firmware revision 24.052.
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Chapter 1          Update Considerations
Download the Redundancy 
Firmware Bundle and RMCT

To download the appropriate redundancy firmware bundle, follow these steps:
1. Go to Find Downloads.

2. Search for “Enhanced Redundancy”. 
3. Click on the Redundancy Bundle.

4. Select the appropriate Enhanced Redundancy Bundle version.
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Chapter 1          Update Considerations
5. Select the redundancy bundle, and click Downloads.

6. Select Firmware Only.

7. Click Downloads.
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Chapter 1          Update Considerations
8. On the Download Cart dialog, make sure that the firmware is selected, 
and click Download now.

9. You have to log in to download the redundancy firmware bundle. 
Follow the download instructions on the website.

The RMCT is included in the downloads for most redundancy bundles. For 
redundancy bundles that use firmware revision 20.007 or later for 1756-RM2 
modules, the RMCT is included in the redundancy bundle and is not available 
for separate download.
Rockwell Automation Publication 1756-RM010H-EN-P - January 2021 13
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For redundancy bundles that use firmware revision earlier than 20.007, you 
can download the RMCT separately as a product add-on:

1. Go to Find Downloads.

2. Search for your controller.
3. Search for the redundancy module. 
4. You can select the RMCT as part of the Product Add-Ons download.

Install the Redundancy 
Firmware Bundle

This section details how to install the Redundancy Firmware Bundle.
• To update to revision 24.052_kit1, see Install the revision 24.052_kit1 

Redundancy Firmware Bundle on page 15
• To update to revision 24.053_kit1, see Install the Revision 24.053_kit1 

Redundancy Firmware Bundle on page 16. 
• To update to revision 30.051_kit1, see Install the Revision 30.051_kit1 

Redundancy Firmware Bundle on page 17.
• To update to revision 30.051_kit2, see Install the Revision 30.051_kit2 

Redundancy Firmware Bundle on page 18.
• To update to revision 31.052_kit1, see Install the Revision 31.052_kit1 

Redundancy Firmware Bundle on page 19.
• To update to revision 31.052_kit2, see Install the Revision 31.052_kit2 

Redundancy Firmware Bundle on page 20.
• To update to revision 32.051_kit1, see Install the Revision 32.051_kit1 

Redundancy Firmware Bundle on page 21.
• To update to revision 33.051_kit1, see Install the Revision 33.051_kit1 

Redundancy Firmware Bundle on page 22.
• To update to revision 33.051_kit2, see Install the Revision 33.051_kit2 

Redundancy Firmware Bundle on page 23.
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Chapter 1          Update Considerations
Install the revision 24.052_kit1 Redundancy Firmware Bundle

If you are updating to revision 24.052_kit1, follow the steps in the section. 

Before you update software for your redundant system, use one of these 
methods to shut down RSLinx® Classic software:

• Right-click the RSLinx Classic icon in the notification area of the screen 
and choose Shutdown RSLinx Classic.

• With RSLinx Classic software open, from the File menu, choose Exit 
and Shutdown.

1. Browse to the location of the redundancy firmware revision 24.052_kit1
2. Unzip the redundancy firmware kit on your computer.
3. Browse to the directory on your computer that has the redundancy 

firmware bundle, and unzip the Redundancy Module Configuration 
Tool version 8.3.1.0 on your computer.

4. Browse to the directory on your computer that has the redundancy 
firmware kit, and double-click ControlFlash.msi.

5. When the installation is complete, a dialog appears.
6. Clear the Yes, I want to launch ControlFLASH™ checkbox.

7. Click Close.

Create a 24.052 firmware directory on your computer first, so you 
can unzip the firmware files to this directory.
Rockwell Automation Publication 1756-RM010H-EN-P - January 2021 15
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Install the Revision 24.053_kit1 Redundancy Firmware Bundle

If you are updating revision 24.053_kit1, follow the steps in this section. 

Before you update software for your redundant system, use one of these 
methods to shut down RSLinx Classic software:

• Right-click the RSLinx Classic icon in the notification area of the screen 
and choose Shutdown RSLinx Classic.

• In RSLinx Classic software, from the File menu, choose Exit and 
Shutdown.

1. Browse to the location of the redundancy firmware revision 24.053_kit1
2. Unzip the redundancy firmware kit on your computer.
3. Browse to the directory on your computer that has the redundancy 

firmware bundle, and unzip the Redundancy Module Configuration 
Tool version 8.4.1.0 on your computer. 

4. Browse to the directory on your computer that has the redundancy 
firmware kit, and double-click ControlFlash.msi.

5. When the installation is complete, a dialog appears.

6. Clear Yes, I want to launch ControlFLASH.

7. Click Close.

Create a 24.053 firmware directory on your computer first, so you 
can unzip the firmware files to this directory.
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Install the Revision 30.051_kit1 Redundancy Firmware Bundle

If you are updating to revision 30.051_kit1, follow the steps in this section. 

Before you update software for your redundant system, use one of these 
methods to shut down RSLinx Classic software:

• Right-click the RSLinx Classic icon in the notification area of the screen 
and choose Shutdown RSLinx Classic.

• In RSLinx Classic software, from the File menu, choose Exit and 
Shutdown.

1. Browse to the location of redundancy firmware revision 30.051_kit1.
2. Unzip the redundancy firmware bundle on your computer.
3. Browse to the directory on your computer that has the redundancy 

firmware bundle, and unzip the Redundancy Module Configuration 
Tool version 8.4.1.0 on your computer.

4. Browse to the directory on your computer that has the redundancy 
firmware kit, and double-click 30.051_Kit1_Redundancy_DMKs.exe.

5. On the WinZip Self-Extractor dialog, click Browse and choose the 
location to install the files.

6. After you choose your location, click extract.
7. On the installation successful dialog, click OK

8. On the WinZip Self-Extractor dialog, click Close.

Create a 30.051 firmware directory on your computer first, so you 
can unzip the firmware files to this directory.
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Install the Revision 30.051_kit2 Redundancy Firmware Bundle

If you are updating to revision 30.051_kit2, follow the steps in this section. 

Before you update software for your redundant system, use one of these 
methods to shut down RSLinx Classic software:

• Right-click the RSLinx Classic icon in the notification area of the screen 
and choose Shutdown RSLinx Classic.

• In RSLinx Classic software, from the File menu, choose Exit and 
Shutdown.

1. Browse to the location of redundancy firmware revision 
V30.051_kit2_ENHCLXRED.zip.

2. Unzip the redundancy firmware bundle on your computer. After you 
unzip, you will have these files:

• Firmware: V30.051_kit2_CLXRED.dmk
• Redundancy Module Configuration Tool version 8.05.01: 

Red_Mod_CT_V8.5.1.0.zip
3. Unzip the Redundancy Module Configuration Tool version 8.05.01 on 

your computer.

IMPORTANT If a system is at 30.051_kit2, and uses Ethernet modules with firmware 
revision 11.003 or ControlNet modules with firmware revision 25.006, it is 
not possible to update to 31.052_kit1 or 31.052_kit2.

Create a 30.051 firmware directory on your computer first, so you 
can unzip the firmware files to this directory.
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Install the Revision 31.052_kit1 Redundancy Firmware Bundle

If you are updating to revision 31.052_kit1, follow the steps in this section. 

Before you update software for your redundant system, use one of these 
methods to shut down RSLinx Classic software:

• Right-click the RSLinx Classic icon in the notification area of the screen 
and choose Shutdown RSLinx Classic.

• In RSLinx Classic software, from the File menu, choose Exit and 
Shutdown.

1. Browse to the location of redundancy firmware revision 
V31.052_kit1_ENHCLXRED.zip.

2. Unzip the redundancy firmware bundle on your computer. After you 
unzip, you have these files:

• Firmware: V31.052_kit1_CLXRED.dmk
• Redundancy Module Configuration Tool version 8.05.01: 

Red_Mod_CT_V8.5.1.0.zip
3. Unzip the Redundancy Module Configuration Tool version 8.05.01 on 

your computer.

Create a 31.052_kit1 firmware directory on your computer first, so 
you can unzip the files to this directory.
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Install the Revision 31.052_kit2 Redundancy Firmware Bundle

If you are updating to revision 31.052_kit2, follow the steps in this section.

Before you update software for your redundant system, use one of these 
methods to shut down RSLinx Classic software:

• Right-click the RSLinx Classic icon in the notification area of the screen 
and choose Shutdown RSLinx Classic.

• In RSLinx Classic software, from the File menu, choose Exit and 
Shutdown.

1. Browse to the location of redundancy firmware revision 
V31.052_kit2_ENHCLXRED.zip.

2. Unzip the redundancy firmware bundle on your computer. After you 
unzip, you will have these files:

• Firmware: V31.052_kit2_CLXRED.dmk
• Redundancy Module Configuration Tool version 8.05.01: 

Red_Mod_CT_V8.5.1.0.zip
3. Unzip the Redundancy Module Configuration Tool version 8.05.01 on 

your computer.

IMPORTANT If a system is at 31.052_kit2, and uses Ethernet modules with 
firmware revision 11.002, it is not possible to update to 32.051_kit1.

Create a 31.052_kit2 firmware directory on your computer first, 
so you can unzip the files to this directory.
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Install the Revision 32.051_kit1 Redundancy Firmware Bundle

If you are updating to revision 32.051_kit1, follow the steps in this section. 

Before you update software for your redundant system, use one of these 
methods to shut down RSLinx Classic software:

• Right-click the RSLinx Classic icon in the notification area of the screen 
and choose Shutdown RSLinx Classic.

• In RSLinx Classic software, from the File menu, choose Exit and 
Shutdown.

1. Browse to the location of redundancy firmware revision 
V32.051_kit1_ENHCLXRED.zip.

2. Unzip the redundancy firmware bundle on your computer. After you 
unzip, you will have these files:

• Firmware: V32.051_kit1_CLXRED.dmk
• Redundancy Module Configuration Tool version 8.05.01: 

Red_Mod_CT_V8.5.1.0.zip
3. Unzip the Redundancy Module Configuration Tool version 8.05.01 on 

your computer.

Create a 32.051 firmware directory on your computer first, so you 
can unzip the files to this directory.
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Install the Revision 33.051_kit1 Redundancy Firmware Bundle

If you are updating to revision 33.051_kit1, follow the steps in this section. 

Before you update software for your redundant system, use one of these 
methods to shut down RSLinx Classic software:

• Right-click the RSLinx Classic icon in the notification area of the screen 
and choose Shutdown RSLinx Classic.

• In RSLinx Classic software, from the File menu, choose Exit and 
Shutdown.

1. Browse to the location of redundancy firmware revision 
V33.051_kit1_ENHCLXRED.zip.

2. Unzip the redundancy firmware bundle on your computer. After you 
unzip, you will have these files:

• Firmware: V33.051_kit1_CLXRED.dmk
• Redundancy Module Configuration Tool version 8.05.01: 

Red_Mod_CT_V8.5.1.0.zip
3. Unzip the Redundancy Module Configuration Tool version 8.05.01 on 

your computer.

Create a 33.051 firmware directory on your computer first, so you 
can unzip the files to this directory.
22 Rockwell Automation Publication 1756-RM010H-EN-P - January 2021



Chapter 1          Update Considerations
Install the Revision 33.051_kit2 Redundancy Firmware Bundle

If you are updating to revision 33.051_kit2, follow the steps in this section. 

Before you update software for your redundant system, use one of these 
methods to shut down RSLinx Classic software:

• Right-click the RSLinx Classic icon in the notification area of the screen 
and choose Shutdown RSLinx Classic.

• In RSLinx Classic software, from the File menu, choose Exit and 
Shutdown.

1. Browse to the location of redundancy firmware revision 
V33.051_kit2_ENHCLXRED.zip.

2. Unzip the redundancy firmware bundle on your computer. After you 
unzip, you will have these files:

• Firmware: V33.051_kit2_CLXRED.dmk
• Redundancy Module Configuration Tool version 8.05.01: 

Red_Mod_CT_V8.5.1.0.zip
3. Unzip the Redundancy Module Configuration Tool version 8.05.01 on 

your computer.

Create a 33.051 firmware directory on your computer first, so you 
can unzip the files to this directory.
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Install the Redundancy 
Module Configuration Tool

If needed, install the latest version of the RMCT.

1. Browse to the RMCT directory on your computer.

2. Double-click setup.exe.

3. On the RMCT Setup dialog, click Next.

4. When the installation is complete, click Finish.

IMPORTANT If you have RMCT version 7 or earlier, it does not support the 1756-RM2 
modules. For more information on the RMCT, see Knowledgebase article 
Redundancy Module Configuration Tool (RMCT).

IMPORTANT You must uninstall any existing version of the Redundancy Module 
Configuration Tool (RMCT) before you install the RMCT, version 8.4.1.0 or 
later. If you do not uninstall the previous version, you can have difficulty 
if you try to uninstall version 8.5.1.0 or later at another time.
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Install the Logix Designer 
Application

This section describes how to install the Logix Designer application version 
that is compatible with your redundancy firmware bundle.

1. If your controller project is online, go offline.

2. Exit out of the programming software.
3. Download and install the version of Studio 5000 Logix Designer 

application that is compatible with your redundancy firmware bundle.
4. Continue with Prepare the Controller Project for the Update on 

page 25.

Prepare the Controller 
Project for the Update

To prepare the controller project and controllers for the update, complete these 
steps.

1. Start the Logix Designer application, and select your redundancy 
project.

2. Go online with the primary controller.
3. To make sure that your off-line project has the latest updates, or in case 

you do not have an off-line file, upload the project from the primary 
controller.

4. Verify that the watchdog time is set to a value that corresponds with the 
requirements of the redundancy system revision and your application.

5. Cancel or assemble any pending test edits.
6. Remove all sequential function chart (SFC) forces from the project.
7. Verify that no changes are required for the following:

- I/O forces
- I/O configuration

After this step, changes to I/O cannot be made until after the 
redundancy system revision update is complete and both chassis are 
synchronized.

8. Save the project.
9. Go offline.

IMPORTANT If you update your programming software from version 20 to version 24, 
and the controller’s project was created in software version 23, we 
strongly recommend that you read Knowledgebase Article RSLogix 
5000® Software, Version 20.03.
A login is required to access the article.
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10. Click Controller Properties.

11. Click Change Controller.

12. Specify the controller revision that you are upgrading to.
13. If you install a new controller while upgrading the secondary chassis 

firmware, specify the new controller catalog number.
14. Click OK.

The Logix Designer application converts the project to the later 
revision.

15. Access the Module Properties for each communication module in the 
chassis and specify the module firmware revision that you are 
upgrading to.

If you are unable to specify the new revision, you must change 
the Electronic Keying parameter to Compatible Module. You 
must also select the highest available firmware revision.
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16. Save the project.
17. If your project contains LINT tags inside a UDT, or you use 

produce/consume tags with LINT member, you must make sure the 
LINT members and UDTs with LINT Members align on 8-byte 
boundaries. See the following:
a. Align LINT Members on 8-byte Boundaries on page 51
b. Logix Designer online help topic: ‘LINT data types within this tag 

now align on 8-byte boundaries. Check produce/consume 
connection’.

18. Continue with Update the Redundancy System Firmware on page 27.

Update the Redundancy 
System Firmware

You can update redundancy firmware to another revision while your process 
continues to run. This update is known as Redundancy System Update (RSU).

IMPORTANT Remember the following before using this section:
• RSU is available when upgrading only from one redundancy version to 

another.
• You can update only from firmware revision 20.054 or later with this 

section. 
• RSU support for enhanced redundancy starts at 16.081
• The process for going to versions prior to V24 are documented in the 

release notes of the version of interest.
• If you update from revision 20.054 to revision 30.051, you must first 

update to revision 24.053 before you update to revision 30.051.
• If you update from revision 24.052 (or a later revision in V24) to revision 

31.052, you must first update to revision 30.051 before you update to 
revision 31.052.

• If you update from revision 24.052 to revision 32.051, you must first 
update to revision 30.051, and then update to revision 31.052 before you 
update to revision 32.051.

• If you update from revision 24.052 to revision 33.051, you must first 
update to revision 30.051, then update to revision 31.052, and then update 
to revision 32.051 before you update to revision 33.051.

You must use this process if the following conditions exist:
• You are upgrading from a redundancy system to revision 24.052_kit1 or 

later.
• Your project does not require EtherNet/IP™ modules to use Electronic 

Keying = Exact Match.
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Before You Begin

Consider these points before you begin upgrading your redundancy system to 
a new revision:

• During the update procedures, you cannot use the programming 
software to change the mode of the controller. Instead, use the mode 
switch on the front of the controller.

• If you are using a ControlNet® network, leave RSNetWorx™ for 
ControlNet software closed or offline throughout this procedure. If the 
software is open or online, you see errors in the RSNetWorx for 
ControlNet software during the update process. 

• Remember the following when completing the tasks described in the 
rest of this section:
- Do not change the project other than with changes that are 

identified in these tasks.
- Verify that no one else is also changing the project.
- Do not use a FactoryTalk® Batch Server to change equipment phase-

states when upgrading your redundancy system.

Complete the steps in this table to update your redundancy system from one 
redundancy system revision to another redundancy revision while your 
process continues to run.

IMPORTANT If your system has 1756-RM or 1756-RMXT modules, you must replace 
them with 1756-RM2 or 1756-RM2XT modules. See Replace a 1756-RM 
Module with a 1756-RM2 Module on page 51 for more information.

Task Page
Prepare the Redundant Chassis for the Firmware Update 29
Update the Redundancy Module Firmware in the Primary Chassis 30
Update Redundancy Module Firmware and Other Module Firmware in the Secondary Chassis 32
Lock the System and Initiate a Switchover to Update 33
Update the New Secondary Chassis Firmware 35
Synchronize the Redundant Chassis 37

WARNING: While you complete the processes to update the redundancy system 
firmware, you will not have a redundant system. The controller runs the machinery 
without a backup until the update is completed.
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Prepare the Redundant Chassis for the Firmware Update

Complete these steps to prepare both the primary and secondary redundant 
chassis for redundancy firmware updates. 

1. Set the mode switch of the primary and secondary controllers to REM.

If the redundant controllers in both chassis of the redundant chassis 
pair are not in Remote RUN (REM) mode, the redundancy firmware 
update cannot be completed.

2. Open RSLinx Classic software and browse to the redundancy module.
3. To open the RMCT, right-click the redundancy module and choose 

Module Configuration.

4. Click the Configuration tab in the RMCT.
5. From the Auto-Synchronization pull-down menu, choose Never.

6. Click Apply, and then click Yes.
7. Click the Synchronization tab.

8. Click Disqualify Secondary.
9. On the RMCT Confirmation dialog, click Yes.
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The secondary chassis is disqualified as indicated by the RMCT at the 
bottom-left of the RMCT and on the status display of the redundancy 
module.

10. Click OK, and close the RMCT.

If you close the RMCT, it helps prevent a timeout from occurring when 
the firmware of the redundancy module is updated.

11. Continue with Update the Redundancy Module Firmware in the 
Primary Chassis on page 30.

Update the Redundancy Module Firmware in the Primary Chassis

Make sure that the primary chassis is powered on. If you have to power on the 
chassis, wait at least 45 seconds after powerup before you begin the update. 
During this time, the redundancy module conducts internal power-up 
sequence operations and is not ready for an update.

Complete these steps to update the redundancy module firmware in the 
primary chassis.

1. Launch ControlFLASH software and click Next.
2. Before you select a target device, you must first tell ControlFLASH 

where to look for firmware files. On the ControlFLASH dialog, click 
Browse.

IMPORTANT If your system has 1756-RM or 1756-RMXT modules, you must 
replace them with 1756-RM2 or 1756-RM2XT modules. See Replace 
a 1756-RM Module with a 1756-RM2 Module on page 51 for more 
information.

Status in RMCT
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3. On the Firmware Kit Location dialog, if the location where you store 
firmware files is not in the Monitored folders list:

a. Click Add.

b. On the Browse for Folder dialog, select the location of your firmware files.

c. Click OK.
4. On the ControlFlash dialog, select the redundancy module catalog 

number as the target device.
5. Click Next
6. Browse to the redundancy module in the primary chassis and select it.

7. Click OK.
8. Select the firmware revision to update to and click Next.
9. Click Finish. The firmware begins to update. When the update is 

complete, the Update status dialog box indicates completion
.

10. On the Update Status dialog, click OK.
11. Close ControlFLASH.

Secondary Chassis

Primary Chassis
Rockwell Automation Publication 1756-RM010H-EN-P - January 2021 31



Chapter 1          Update Considerations
Update Redundancy Module Firmware and Other Module Firmware in 
the Secondary Chassis

Make sure that the secondary chassis is powered on. If you have to power on 
the chassis, wait at least 45 seconds before you begin the secondary update. 
During this time, the redundancy module conducts internal power-up 
sequence operations and is not ready for an update.

Complete these steps to update the firmware in the secondary chassis.
1. If you want to replace your module hardware, remove the module from 

the secondary chassis and replace it with the new module.

2. Launch ControlFLASH, and click Next.
3. Select the module catalog number and click Next.

4. Browse to the redundancy module in the secondary chassis and select 
it.

5. Click OK.
6. Select the firmware revision to update to and click Next.

IMPORTANT When replacing communications modules, make sure that 
the node address (for ControlNet modules), rotary 
switches, and Port Configuration (for Ethernet modules) 
match the existing modules.
If you replace EtherNet/IP or ControlNet communication 
modules as part of this redundancy update, make sure 
that you have read through and are familiar with the 
Replacement Considerations on page 39.

Primary Chassis

Secondary Chassis
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7. Click Finish.

The firmware begins to update. When the update is complete, the 
Update status dialog box indicates completion.

8. On the Update status dialog, click OK.
9. Repeat  steps 1 …8 for each module in the secondary chassis.
10. Close ControlFLASH.
11. Download the project to the secondary controller.

.

12. After the download is complete, go offline.

You are now ready to lock the system and initiate a locked switchover to update 
the primary chassis. Continue with Lock the System and Initiate a Switchover 
to Update.

Lock the System and Initiate a Switchover to Update

Once you have downloaded the controller project, complete these steps to lock 
the system and initiate a switchover.

IMPORTANT When you download a project that has I/O forces enabled, the 
application prompts you to enable or disable forces after the 
download completes.
After the locked switchover, the forces are whatever you selected 
(enabled or disabled).

IMPORTANT Remain offline with your controller while completing these steps.
• Once you have locked the system, do not abort the system lock. 

Aborting the system lock during this procedure clears the project from 
the secondary controller.

• Do not disconnect any communication cables while completing these 
steps.

• Completing a locked switchover causes SFC instructions to be reset to 
their initial state. This action can cause the SFC instructions to 
execute twice.
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1. In RSLinx Classic software, right-click the redundancy module in the 
primary chassis and choose Module Configuration to open the RMCT.

2. Click the System Update tab
.

3. Click Lock For Update, and then click Yes at the Redundancy 
Configuration Tool dialog box.

4. Wait for the system to lock.

The System Update Lock Attempts log indicates when the system lock is 
complete.

5. Click Initiate Locked Switchover, and then click Yes at the Redundancy 
Configuration Tool dialog box.

IMPORTANT For errors associated with Lock For Update, see Knowledgebase 
Article Lock for Update Fails.
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Your secondary chassis assumes control and becomes the primary 
chassis. When the switchover is complete, the Locked Switchover 
Attempts log indicates success.

The text in chassis status row indicates the switchover state in 
combination with the log.

Once your locked switchover is complete, update the firmware revisions for 
modules in the new secondary chassis.

6. On the RMCT, click OK.

Update the New Secondary Chassis Firmware

To update the firmware of all modules in the new secondary chassis, complete 
these steps.

1. If you are replacing and upgrading your module hardware, remove the 
module from the secondary chassis and replace it with the new module.

2. Launch ControlFLASH software and click Next.

IMPORTANT After the locked switchover, the new secondary controllers no longer 
contain a user application and their configuration settings are reset to 
the factory-default settings.
The new secondary controllers use the default settings, and the 
components in the secondary chassis are updated and the system is 
synchronized.

IMPORTANT Update the Gateway address of the primary chassis Ethernet module to 
192.168.1.1, if you are upgrading from a system using revision 20.054_kit1, 
20.055_kit1, 20.055_kit2, 20.055_kit3, 20.055_kit4, or 20.056_kit1 and 
Electronic Keying is set to Exact Match, Compatible Module or Disable 
Keying and you are either:
• Updating 1756-EN2T/C (or earlier) modules with 1756-EN2T/C (or earlier) 

modules, and the modules being replaced have rotary switches set to 
2…254.

• Replacing 1756-EN2T/C (or earlier) modules with EN2T/D modules, and 
the modules being replaced have rotary switches set to 2…254.

IMPORTANT When replacing communications modules, make sure that the 
node address (for ControlNet modules), rotary switches, and Port 
Configuration (for Ethernet modules) match the existing 
modules.
If you replace EtherNet/IP or ControlNet communication modules 
as part of this redundancy update, make sure that you have read 
through and are familiar with the Replacement Considerations on 
page 39.
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3. Select the module catalog number and click Next.

4. Browse to the module and select it.

5. Click OK.
6. Select the firmware revision to update to and click Next.
7. Click Finish.

The firmware begins to update. When the update is complete, the 
Update status dialog box indicates completion.

8. Complete steps 1 …7 for each module in the new secondary chassis, 
including the new controllers, if applicable.

Once you either replace or update the firmware for each of the modules in the 
new secondary chassis, continue with Synchronize the Redundant Chassis on 
page 37.

Primary Chassis

Secondary Chassis
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Synchronize the Redundant Chassis

To synchronize the redundant chassis after firmware in both chassis have been 
updated to the same revision, complete these steps.

1. In RSLinx software, right-click the 1756-RM2 or 1756-RM2XT module in 
the primary chassis and choose Module Configuration to open the 
RMCT.

2. On the Synchronization tab, click Synchronize Secondary.

3. On the RMCT Confirmation dialog, click Yes.

Wait for synchronization to complete.

 Steps 4…8 are only applicable if the Ethernet switches are set between 
2…254.

4. Initiate a switchover.

5. In the new secondary, set the rotary switches back to the original 
configuration.

6. Repeat this process for all Ethernet modules that need the rotary 
switches set back to 2…254.
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7. From the Auto-Synchronization pull-down menu, choose the option 
that suits your application.

8. If necessary, manually synchronize the chassis. 

9. Set the redundancy module date and time according to your 
preference.

10. Click OK.
11. Close the RMCT.

EDS Files

If you see modules that are displayed in RSLinx Classic with yellow question 
marks, the EDS files for the modules are not registered. You can right-click on 
the module and proceed with the “Upload EDS files from device” wizard to 
upload the EDS file. If this option is not available or as an alternative, follow 
this link to obtain the EDS files for modules in your system: 
Electronic Data Sheets (EDS).

1. Download the required EDS file.
2. Choose Start > Programs > Rockwell Software® > RSLinx Tools > EDS 

Hardware Installation Tool. 

The tool then prompts you to Add or Remove EDS files.

Your redundant system firmware update is now complete.
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Replacement Considerations

Before You Begin When replacing modules in ControlLogix® redundancy systems, there are 
considerations for these situations:

• Replace a module in the secondary chassis
• Replace an EtherNet/IP™ or ControlNet® communication module
• Replace a 1756-RM or 1756-RMXT module with a 1756-RM2 or 

1756-RM2XT module

Replace a Module in the 
Secondary Chassis That 
Has the Same Catalog 
Number and Firmware 
Revision

These steps are used when performing a direct communication module 
replacement, for example, when replacing a communication module in the 
secondary chassis with a module that has the same:

• Catalog number
• Series
• Firmware (after updating the firmware, if necessary)

When you replace communication modules, make sure that the node address 
(for ControlNet modules), rotary switches, and Port Configuration (for 
EtherNet/IP modules) match the existing modules.

1. Using the Redundancy Module Configuration Tool (RMCT):
a. Set Auto-Synchronization to Never.

b. Disqualify the redundant chassis pair (if not already disqualified).
2. Remove the module from the secondary chassis and replace it with the 

new module.

Topic Page

Before You Begin 39

Replace a Module in the Secondary Chassis That Has the Same Catalog 
Number and Firmware Revision 39

Replace an EtherNet/IP Module with a New Series 40

Replace a 1756-CN2 Module with a New Series 45

Replace a 1756-RM Module with a 1756-RM2 Module 49
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3. If applicable, update the module firmware by using ControlFLASH™ or 
ControlFLASH Plus™ software.

4. In the RMCT, from the Auto-Synchronization pull-down menu, choose 
your preferred method.

5. If necessary, manually synchronize the chassis.

Replace an EtherNet/IP 
Module with a New Series

This section describes how to replace EtherNet/IP communication modules in 
a redundancy system without the need for a controller update.

You can replace the EtherNet/IP modules by using the following methods:

• Synchronization and Switchover for EtherNet/IP Modules

Use this method if Electronic Keying is not set to Exact match.
• Update the Redundancy System Firmware

Use this method if Electronic Keying is set to Exact Match. You must 
configure the new modules to use Exact Match.

IMPORTANT Consider the following:
• Before replacing modules, make sure that you have the correct firmware 

for all new modules.
• When you replace modules, you must do so in pairs or the system cannot 

synchronize after a switchover.
• Partnered pairs of EtherNet/IP modules must use the same values for the 

following parameters for IP address swapping to work: 
IP addresses, Network mask, Gateway address
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Synchronization and Switchover for EtherNet/IP Modules

Complete these steps to replace EtherNet/IP modules with new series 
modules.

1. Make sure the existing module and replacement module use the same 
IP, Network Mask, and Gateway addresses.

2. For the Redundancy Module Configuration Tool (RMCT):
• With redundancy firmware revision 24.052, make sure that the 

RMCT is at version 8.03.01 or later.
• With redundancy firmware revision 30.051, make sure that the 

RMCT is at version 8.04.01 or later.
• With redundancy firmware revision 24.053, 31.052, 32.051, or 

33.051,make sure that the RMCT is at version 8.05.01.
3. Make sure that the redundancy module firmware is at the firmware 

revision for the specified bundle for only 1756-RM2 and 1756-RM2XT 
modules.

4. Go online with the primary controller.
5. For each module, verify that the Electronic Keying is set to Compatible 

Module or Disable Keying.

6. In the RSLinx® Classic software, start the RMCT for the redundancy 
module in either chassis.

7. On the Configuration tab, from the Auto-Synchronization pull-down 
menu, choose Never.

8. Click Apply.
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9. On the Synchronization tab, click Disqualify Secondary.

10. Make a note of the Port Configuration of the secondary Ethernet 
module.
• IP address
• Network Mask
• Gateway address

11. Disconnect the Ethernet cables from the secondary Ethernet module.
12. Turn off power to the secondary chassis.
13. Remove the EtherNet/IP module from the secondary chassis.
14. Set the switches on the new EtherNet/IP module to 888, insert the 

module in the secondary chassis, and apply power to the chassis.
a. After the reset is complete, turn power off to the secondary chassis, 

remove the module from the secondary chassis.
b. Set the switches to the same settings as on the module that was 

removed.
c. Reinsert the module into the secondary chassis, reattach the cable, 

and apply power to the secondary chassis.
d. To support bridging across the backplane (or via the USB port), 

configure the Port Configuration of the secondary module to match 
the Port Configuration of the primary module.
42 Rockwell Automation Publication 1756-RM010H-EN-P - January 2021



Chapter 2          Replacement Considerations
15. If you have not already done so, update the firmware of the new 
EtherNet/IP module.
a. Launch ControlFLASH software, and click Next.
b. Select the Ethernet module catalog number and click Next.

c. Browse to the module in the secondary chassis and select it.

d. Click OK.
e. Select the firmware revision to update to and click Next.
f. Click Finish.

The firmware begins to update. When the update is complete, the 
Update status dialog box indicates completion.

Wait for the update to complete.
g. After the update completes, connect the Ethernet cable to the 

secondary Ethernet module, and wait for communication to resume 
on the network.

16. Repeat steps 10…15 for all EtherNet/IP modules in the secondary 
chassis.

Secondary 
Chassis
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Complete these steps to verify module compatibility and synchronization.
1. At the Synchronization status tab, verify that the Synchronization 

Status tab indicates that the modules are fully compatible.

2. On the Synchronization tab, synchronize the secondary chassis.

Wait for synchronization to complete.

3. Initiate a switchover.

4. Disconnect the Ethernet cables from the secondary Ethernet module.
5. Turn off power to the secondary chassis.
6. Remove the module from the secondary chassis.
7. Set the switches on the new EtherNet/IP module to 888 and insert it in 

the secondary chassis.
a. After the reset is complete, remove the module from the secondary 

chassis.
b. Set the switches to the same settings as on the module that was 

removed.
c. Reinsert the module into the secondary chassis, reattach the cable, 

and apply power to the secondary chassis.
d. To support bridging across the backplane (or via the USB port), 

configure the Port Configuration of the secondary module to match 
the Port Configuration of the primary module.

e. If you have not already done so, update the firmware of the new 
EtherNet/IP module.

8. Repeat the steps 4… 7 for all EtherNet/IP modules in secondary chassis.
9. On the Configuration tab, from the Auto-Synchronization pull-down 

menu, choose Always.

10. Click Apply, Yes, and OK.
11. Verify that the secondary chassis has qualified.
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Replace a 1756-CN2 Module 
with a New Series

This section describes how to replace ControlNet communication modules in a 
redundancy system. You can replace the 1756-CN2/B modules with 
1756-CN2/C modules by using the following methods:

• Synchronization and Switchover for the ControlNet Modules

Use this method if Electronic Keying is set to Disable or Compatible 
Module.

• Update the Redundancy System Firmware

Use this method if Electronic Keying is set to Exact Match.

Synchronization and Switchover for the ControlNet Modules

Complete these steps to replace ControlNet modules.

1. Add the EDS files for the modules, if you have not already done so.
2. Make a note of the Node configuration of the ControlNet module.

In this example, the primary ControlNet Node is configured to be Node 
11. The Node value of the secondary ControlNet module must be the 
same value as the primary module.

3. For the Redundancy Module Configuration Tool (RMCT):
• With redundancy firmware revision 24.052, make sure that the 

RMCT is at version 8.03.01 or later.
• With redundancy firmware revision 30.051, make sure that the 

RMCT is at version 8.04.01or later.
• With redundancy firmware revision 24.053, 31.052, 32.051, 33.051, 

make sure that the RMCT is at version 8.05.01 

IMPORTANT • Before replacing modules, make sure that you have the correct firmware 
for all new modules.

• When you replace modules, you must do so in pairs or the system cannot 
synchronize after a switchover. 

• When you update 1756-CN2/B modules to 1756-CN2/C modules, you must 
do so in pairs. If not, the system cannot synchronize after a switchover.

• Replace 1756-CN2/B with 1756-CN2/C, and 1756-CN2RXT/B modules with 
1756-CN2RXT/C modules.
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4. For the 1756-RM2 and 1756-RM2XT modules:
• With redundancy firmware revision 24.052, make sure that the 

redundancy module firmware is revision 20.007.
• With redundancy firmware revision 24.053, or 30.051, make sure that 

the redundancy module firmware is revision 20.009.
• With redundancy firmware revision 31.052, 32.051, or 33.051, make 

sure that the redundancy module firmware is revision 20.010.
5. Go online with the primary controller.
6. For each module, verify that Electronic Keying is set to Compatible 

Module or Disable Keying. 

7. In the RSLinx® Classic software, start the RMCT for the redundancy 
module in the primary chassis.

a. Start RSLinx® Classic Software.
b. Select Communications and choose RSWho.
c. Open the branches of your network until you find the redundancy 

module in the primary chassis.
d. Right-click the redundancy module, and choose Module 

Configuration.
8. On the Configuration tab, from the Auto-Synchronization pull-down 

menu, choose Never.

9. Click Apply and then Yes.
10. On the Synchronization tab, click Disqualify Secondary and then click 

Yes. 
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11. Disconnect the coaxial cables from the secondary ControlNet module.
12. Remove the original ControlNet module from the secondary chassis.
13. Set the switches in the new module to 00 and insert the module into the 

secondary chassis.
14. After the reset is complete in the new ControlNet module, remove the 

module from the secondary chassis.
15. Set the switches in the new ControlNet module to the correct Node 

value and reinsert the module into the secondary chassis.
16. Reconnect the coaxial cable to the new secondary ControlNet module.
17. Update the firmware of the ControlNet module in the secondary 

chassis.
a. If necessary, complete the following steps to update module 

firmware.
b. Launch ControlFLASH software, and click Next.
c. Select the ControlNet module catalog number and click Next.

d. Browse to the module and select it.

e. Click OK.
f. Select the firmware revision to update to and click Next.
g. Click Finish.

The firmware begins to update. When the update is complete, the 
Update status dialog box indicates completion.

Wait for the update to complete.
18. Wait for communication to resume on the network.
19. Verify that the Synchronization Status tab indicates that the modules 

are fully compatible. 

Secondary Chassis
Rockwell Automation Publication 1756-RM010H-EN-P - January 2021 47



Chapter 2          Replacement Considerations
20. On the Synchronization tab, synchronize the secondary chassis.

Wait for synchronization to complete.

21. Initiate a switchover.

22. Remove the ControlNet modules from the new secondary chassis.
23. Make sure to match the node address of replacing the ControlNet 

module with existing module.
24. Insert the ControlNet module into the new secondary chassis, 

reconnect the module to the network, and turn on power to the chassis.
25. If you have not already done so, update the firmware of the ControlNet 

module in the primary chassis.

Complete these steps to verify module compatibility and synchronization.
1. In the RMCT, from the Auto-Synchronization pull-down menu, choose 

your preferred method.

2. If necessary, manually synchronize the chassis.

3. Click Apply, Yes, and OK.
4. Verify that the secondary chassis has qualified.
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Replace a 1756-RM Module 
with a 1756-RM2 Module

You can replace 1756-RM modules with 1756-RM2 modules without initiating a 
switchover.

1. Install the compatible version of the RMCT software.

You must shut down RSLinx Classic software to install the software, 
and then restart RSLinx Classic software after the installation is 
complete.

2. On the RMCT Configuration tab, from the Auto-Synchronization 
pull-down menu, choose Never.

3. Disqualify the redundant chassis pair (if not already disqualified) by 
using the RMCT.

4. Unplug the fiber cable or cables from both of the redundancy modules.
5. Close any open RMCT sessions that are connected to the current 

redundancy modules that are being replaced.
6. Remove the redundancy module pair (in any order) from the redundant 

chassis.
7. Insert the 1756-RM2 redundancy module pair (in any order) in the 

redundant chassis into the same slots as the redundancy modules.
8. If not already installed, use RSLinx Classic software to upload the EDS 

file for the 1756-RM2 module. If needed, obtain the EDS file for the 
1756-RM2 module.

Follow the procedure that is described in EDS Files on page 38

9. Update the primary and secondary 1756-RM2 modules to the 
appropriate firmware revision.

10. Reconnect the fiber cable on either CH1 or CH2 of the 1756-RM2 
redundancy module.

11. Optional: Connect a second fiber cable on the remaining channel for 
fiber redundancy.

12. Wait for at least 45 seconds after connecting the fiber cables.
13. Launch the RMCT again for the newly installed 1756-RM2 modules.
14. On the RMCT Configuration tab, from the Auto Synchronization 

pull-down menu, choose your original value.
15. Synchronize the system again (if it is not already qualified) by using the 

RMCT.
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Notes:
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Align LINT Members on 8-byte Boundaries

The Studio 5000 Logix Designer® application has requirements for data type 
use. The requirements differ based on the Logix Designer application version 
that you use.

The Logix Designer application manages the requirement automatically, and 
the change has no effect on individual LINT tags, regardless of 
application version.

LINTs inside a UDT can be misaligned in these situations;
• You migrate a standard Logix Designer project, version 26 or earlier, to 

a redundancy project that is version 30.051 or later, and you have LINT 
tags inside a UDT.

• You migrate a redundancy project, version 24.053 or earlier, to a project 
that is version 30.051 or later, and you have LINT tags inside a UDT.

Additional pad bytes are added to the data structure to account for the 
misalignment. The pad bytes can cause an increase in the size of the UDT.

The possible effects of data structure changes, and subsequent actions that you 
can take as a result, are described in the rest of this section.

Possible Impact of Requirement Change

You can adapt your project to accommodate larger structure sizes, if necessary. 
You can see the following effects due to the larger size:

• Message instruction data lengths can require changes to 
complete successfully.

• Copy lengths of data structures can change.
• Produce/Consume connections to other Logix controller types can have 

data type mismatches and require changes to complete successfully.

Logix Designer Application Version Requirement

Version 26 or earlier Logix 5000™ controllers require all data types to be placed on 4-byte 
address boundaries in RAM. 

Version 27 or later Logix 5000 controllers require 8-byte (64-bit) data types (LINTs) to be 
placed on 8-byte address boundaries in RAM. 

IMPORTANT You must also act when your application includes Logix 5000 
controllers, version 26 or earlier, that communicate with Logix 5000 
controllers, version 30.051 or later.
Rockwell Automation Publication 1756-RM010H-EN-P - January 2021 51



Appendix A          Align LINT Members on 8-byte Boundaries
To correct Produce/Consume errors that are caused by UDT alignment 
changes, modify the tag structures in both projects so that they match.

• Produce/Consume with Status requires an exact match of the UDT 
definition (including the name of the UDT definition).

• Produce/Consume without Status requires the Size of the UDT to 
match.

We recommend that you copy and paste the UDT definition from one project 
to the other to cover both of these cases. Use the Data Type editor to check the 
Data Type Size in both projects:

Figure 1 - Data Type Editor

If the data type size is different between the two projects, modify the UDT to 
produce the same internal data structure.

The following sample UDT illustrates how the 8-byte allocation rule and the 8-
byte alignment rule cause a UDT to have another size. 

Figure 2 - UDT Sample - Needs Additional Memory Allocation and Alignment
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Table 1 illustrates how this data structure maps in a Logix Designer project, 
version 24.053 or earlier. MyLint is split across two 64-bit words, and the total 
size is only 32 bytes.

Table 2 illustrates the hidden padding bytes that the Logix Designer 
application automatically adds to achieve the 8-byte alignment and allocation 
rules for a Logix Designer project, version 30.051 or later. 

Consider the following:

• Padding is added in Word 5 so that MyLint starts at an 8-byte boundary.

• Padding is added in Word 9 so that the entire structure is a multiple of 8 bytes.

To create a UDT that is the same size in all types of projects, insert additional 
data elements so that hidden padding bytes are not necessary.

The following sample UDT illustrates how UnusedDint1 and UnusedDint2 
were added to create a UDT with the same size in a Logix Designer project, 
version 24.053 or earlier compared to a Logix Designer project, version 30.051 
or later.

Table 1 - Data Structure for Logix Designer Projects, Version 26 or Earlier

Word Elements Byte Mapping Table 64 Bit Boundaries

0 LimitA and LimitB Pad Pad Pad Hidden
SINT 0

1
Profile (Real [3])

Map Map Map Map
2 Map Map Map Map

1
3 Map Map Map Map
4 Interlock (Int) Pad Pad Map Map

2
5

MyLint (LINT)
Map Map Map Map

6 Map Map Map Map
3

7 Speed (REAL) Map Map Map Map

Table 2 - Hidden Padding Added for Logix Designer Projects, Version 27 or Later

Word Elements Byte Mapping Table 64 Bit Boundaries

0 LimitA and LimitB Pad Pad Pad Hidden
SINT 0

1
Profile (Real [3])

Map Map Map Map
2 Map Map Map Map

1
3 Map Map Map Map
4 Interlock (Int) Pad Pad Map Map

2
5 Padding for 8-byte 

alignment Pad Pad Pad Pad

6
MyLint (LINT)

Map Map Map Map
3

7 Map Map Map Map
8 Speed (REAL) Map Map Map Map

4
9 Padding for 8-byte 

allocation Pad Pad Pad Pad
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Figure 3 - UDT Sample - Memory Allocation and Alignment OK

Table 3 illustrates how this data structure maps in all types of Logix 5000 
controller projects:

The concept is the same for nested UDTs. If the lower-level UDT is an 8-byte 
type (that is, it contains at least one 8-byte data element), you must align it to 
start at an 8-byte boundary.

To correct any mismatched UDTs, complete the following tasks in 
either project:

1. Start at the deepest nesting level of any multi-level UDT.
2. Work from the beginning of each structure and look for LINT data 

types. 
3. For each LINT data type or 8-byte UDT encountered, map out the sizes 

of the prior UDT elements, to determine the byte offset at the start of 
the element.

If the byte offset for the first 8-byte element is not divisible by 8 bytes 
(64 bits), insert a DINT tag element just above the 8-byte element. You 
can use any name. Instructions do not need to reference this element.

4. Repeat the process until all 8-byte elements are aligned on 8-byte 
(64-bit) boundaries.

5. If needed, add a DINT at the end of the UDT to satisfy the 8-byte 
allocation rule.

6. Continue up through nested UDTs until the top level is correct.

Table 3 - Memory Map in All Project Types

Word Elements Byte Mapping Table 64 Bit Boundaries

0 Bools and 2 Pad Pad Pad Hidden
SINT 0

1
Profile (Real [3])

Map Map Map Map
2 Map Map Map Map

1
3 Map Map Map Map
4 Interlock (INT) Pad Pad Map Map

2
5 UnusedDint1 Map Map Map Map
6

MyLint (LINT)
Map Map Map Map

3
7 Map Map Map Map
8 Speed (REAL) Map Map Map Map

4
9 UnusedDint2 Map Map Map Map
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When the tasks are completed, the UDTs are the same size in the 
Logix Designer project, version 24.053 or earlier and the Logix Designer 
project, version 30.051 or later.

A useful technique when creating UDTs is to start with the largest data types 
first, and work down through 8-byte, 4-byte, 2-byte, 1-byte, and finally single-
bit data types. The resultant mapping is 64-bit-aligned in all controller types, so 
no manual padding is required.

Produce/Consume with Status and Safety Produce/Consume tags require an 
adjustment to this technique. For these cases, the UDT must start with a 4-byte 
'COMMAND_STATUS' element; therefore, one more 4-byte element (DINT or 
REAL) must be added before placing any 8-byte elements.
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Notes:
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